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SOLIDWORKS® 2023 Quick Start Overview of SOLIDWORKS® and the User Interface

Chapter 1
Overview of SOLIDWORKS® 2023 and the User Interface
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Below are the desired outcomes and usage competencies based on the completion of
Chapter 1.

Desired Outcomes: Usage Competencies:

e A comprehensive e Ability to establish a SOLIDWORKS session.
understanding of the
SOLIDWORKS® User e Aptitude to utilize the following items: Menu
Interface (UI) and bar toolbar, Menu bar menu, Drop-down
CommandManager. menus, Context toolbars, Consolidated drop-

down toolbars, System feedback icons, Task
Pane, Confirmation Corner, Heads-up View
toolbar, Document Properties and more.

e Open a new and existing SOLIDWORKS part.

e Knowledge to zoom, rotate and maneuver a
three-button mouse in the SOLIDWORKS
Graphics window.
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Notes:
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SOLIDWORKS® 2023 Quick Start Overview of SOLIDWORKS® and the User Interface

Chapter 1 - Overview of SOLIDWORKS® 2023 and the User Interface

Chapter Objective

Provide a comprehensive understanding of the SOLIDWORKS® default User Interface
and CommandManager: Menu bar toolbar, Menu bar menu, Drop-down menu, Right-
click Pop-up menus, Context toolbars/menus, Fly-out tool button, System feedback icons,
Confirmation Corner, Heads-up View toolbar and more.

On the completion of this chapter, you will be able to:

e Utilize the Welcome - SOLIDWORKS dialog box.

e Establish a SOLIDWORKS session.

e Comprehend the SOLIDWORKS User Interface.

e Recognize the default Reference Planes in the FeatureManager.
e Open a new and existing SOLIDWORKS part.

e Utilize Help and SOLIDWORKS Tutorials.

e Zoom, rotate and maneuver a three-button mouse in the SOLIDWORKS Graphics
window.

What is SOLIDWORKS®?

e SOLIDWORKS® is a mechanical design automation software package used to build
parts, assemblies and drawings that takes advantage of the familiar Microsoft®
Windows graphical user interface.

e SOLIDWORKS is an easy to learn design and analysis tool (SOLIDWORKS
Simulation, SOLIDWORKS Motion, SOLIDWORKS Flow Simulation,
Sustainability, etc.), which makes it possible for designers to quickly sketch 2D and
3D concepts, create 3D parts and assemblies and detail 2D drawings.

e Model dimensions in SOLIDWORKS are associative between parts, assemblies and
drawings. Reference dimensions are one-way associative from the part to the drawing
or from the part to the assembly.

e This book is written for the beginner to intermediate user.
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Start a SOLIDWORKS Session

Start a SOLIDWORKS session and familiarize yourself with the SOLIDWORKS User
Interface. As you read and perform the tasks in this chapter, you will obtain a sense of
how to use the book and the structure. Actual input commands or required actions in the
chapter are displayed in bold.

The book does not cover starting a SOLIDWORKS session in detail for the first time. A
default SOLIDWORKS installation presents you with several options. For additional
information, visit http://www.SOLIDWORKS.com.

Activity: Start a SOLIDWORKS Session.

Start a SOLIDWORKS session.

1) Type SOLIDWORKS 2023 in the Search window.

2) Click the SOLIDWORKS 2023 application (or if available, double-
click the SOLIDWORKS icon on the desktop). The Welcome -
SOLIDWORKS dialog box is displayed by default. | £ SOLIDWORKS 2023 |

The Welcome - SOLIDWORKS box provides a convenient way to
open recent documents (Parts, Assemblies and Drawings), view recent folders, B 205
access SOLIDWORKS resources, and stay updated on SOLIDWORKS news. OUSSS

3) View your options. Do not open a document at this time.

Frsouucrs s wis ¢ [Q9) [+ B+ Ll - - 2 -
Welcome - SOLIDWORKS ~
—
ome. Rocent: Leam Alrts Login
3SDEXPERIENCE"
New
o ] Extend
@ parn G pssembly braning Advanced.. ¥ open e
| with the
Recent Documents ew al 3DEXPERIENGE
E. Platform
TANGENT 5LDASH NCI220052 WP SLOA 062 rylon spacerSL. SHAFT COLLARSLDP AHLE SLOPRT
- Connect to the
b (’ @&, fon 3DEXPERIENCE®
) o o | platform and
§ 4 & & LN
g L & B, & eianis
collaboration,
product data and
Iifecycle
< %
management,
Racent Folders Viewall Resources organic shaps
- ) design, simulation
ko & What's New @ Customer Portal Sltione and
) Chapter 2 Homework B MySalidWorks 2 User Groups mare.
(42023 SOLIDWORKS Tutoria i5¥-TUTORIAL 2029 Chap. (Subscription
El ROBOT Assembly & User Forum 1 Get Support required.)
a2 DVIRES Tutariz LEAW-TUTORIAL 2023Chapts... h?
Qo ot s €« com ko 4 o il A ki ke et 10 i < use
3DEXPERIENCE
[ 0a ratshom an startup Marketplace to
source 3D content
and services
worldwide. (N~
‘ ’
50U DWORKS Premium 2023 570 1 |
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SOLIDWORKS® 2023 Quick Start

Overview of SOLIDWORKS® and the User Interface

Home Tab

The Home tab lets you open new and
existing documents, view recent
documents and folders, and access
SOLIDWORKS resources (Part,
Assembly, Drawing, Advanced
mode, Open).

Recent Tab

The Recent tab lets you view a
longer list of recent documents and
folders. Sections in the Recent tab
include Documents and Folders.

Welcome - SOLIDWORKS

nge: Recent Learn  Alerts

—

New

@ part G nssembly Drawing

Advanced

Recent Documents

TANGENT.SLDASM NCI22005Z-MP.SLDA. 062 nylon_spacer.SL.

@ i %
<
Recent Folders View all Resources
Tangent folder .
[ €42023 SCLIDWERKS TutoriahSW-TUTORIAL 206234Cha pte. & What's New

Chapter 2 Homework
€32023 SOLIDWERKS TutoriahSW-TUTORIAL 2023\ Cha pte.

B MysolidWorks

]

B ROBOT Assembl
€42023 SGLIWVORKS Tutoriah s TUTORIAL 20231 Chatte. ©

¥ User Forum

SHAFT-COLLARSLD?..

P open

Wiew &

AXLESLDPRT

@ Customer Portal
4§ User Groups

3 Get support

wing plane. < >

The Documents section includes
thumbnails of documents that you have
opened recently.

Click a thumbnail to open the
document, or hover over a thumbnail
to see the document location and
access additional information about the
document. When you hover over a
thumbnail, the full path and last saved
date of the document appears.

Learn Tab

The Learn tab lets you access instructional
resources to help you learn more about the

SOLIDWORKS software.

Sections in the Learn tab include:

Welcome - SOLIDWORKS

Recent Learn  Alerts

i

Home

Documents  Falders

Quickflier & @‘ EH‘ [ |"‘3-‘*' by name

TANGENT.SLDASH

NCI220052 MP.SLDA. 062 rylon_spacer.sL.

L

SHAFT COLLARSLDP.

7 %

Remove v

AXLESLOPRI

LINKAGE-? Assembly.

ey L )

g ¢ e

AXLES|LDPRT

Welcome - SOLIDWORKS
Home  Recent Lim Alerts

Get Started with
SOLIDWORKS CAD

Step-by-Step Tutorials

on my P

R Certification

& My Training

Featured models on your computer

a

F Curriculum

e Get Started with SOLIDWORKS
CAD. Open the Introducing
SOLIDWORKS book.
o Step-by-Step Tutorials. Open the step- L=
by-step tutorials in the SOLIDWORKS software.
e  MySolidWorks CAD Models. Open the Training section at MySolidWorks.com.
e On my PC. Open local folders containing sample models.
e eCourses. Open the eCourses Training Catalog.
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Overview of SOLIDWORKS® and the User Interface

e My Training. Open the My Training section at MySolidWorks.com.

e Certification. Open the SOLIDWORKS Certification Program section at
solidworks.com. You will need to create an account with a password.

SOLIDWORKS® 2023 Quick Start

e Curriculum. Open the Curriculum section at solidworks.com. You will need to create an
account with a password.

When you install the software, if you do not install the Help Files or Example Files, the
Tutorials and Samples links are unavailable.

Alerts Tab

The Alerts tab keeps you updated e A e

with SOLIDWORKS news.

Sections in the Alerts tab include
Critical, Troubleshooting, and

Technical.

w1
- .

The Critical section does not
appear if there are no critical alerts to

display.

¢ Troubleshooting.
Includes
troubleshooting
messages and
recovered documents
that used to be on the
SOLIDWORKS
Recovery tab in the
Task Pane.

w1

¥ [fthe software has a
technical problem and an

Home  Recent Learn Alerts

Trou‘:l!shonling Technical Alerts

S

Welcome - SOLIDWORKS

Home Recent Learn Alerts
—

oy
Troubleshooting Technical Alerts

3DEXPERIENCE Marketplace for SOLIDWORKS and DraftSight add-in (6.31.534) is available for download
Man, 21 Nov 2022 17:38:18 EST

SOLIDWORKS 2023 SPO0.1 is available for download
Man, 21 Nov 2022 17:33:25 EST

SOLIDWORKS 2022 SP5 is available for download
Mon, 31 Oct 2022 15:29:59 EST

URGENT ALERT: Important update for SOLIDWORKS Simulation 2022 SPQ, SP1, and SP2 now available
Thu, 28 Jul 2022 00:00:00 EST

x

7

associated troubleshooting message exists, the Welcome dialog box opens to the
Troubleshooting section automatically on startup, even if you selected Do not show at

startup in the dialog box.

e Technical Alerts. Open the contents of the SOLIDWORKS Support Bulletins RSS feed
(Hotfixes, release news) at solidworks.com.
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SOLIDWORKS® 2023 Quick Start

Close the Welcome - SOLIDWORKS dialog box.

4) Click Close * from the Welcome - SOLIDWORKS dialog box. The
SOLIDWORKS Graphics window is displayed. You can also click outside
the Welcome - SOLIDWORKS dialog box, in the Graphics window.

View the SOLIDWORKS Graphics window.

Overview of SOLIDWORKS® and the User Interface

Close

2 :
DS SOLIDWORKS File View Tools

Y AR M E LD @O

2
P2S SOLIDWORKS

2023

MeORETaD @

SOLIDWORKS Premium 2023 SP0.1

Menu Bar toolbar

The SOLIDWORKS (UI)

is designed to make
maximum use of the
Graphics window. The
Menu Bar toolbar contains a
set of the most frequently

used tool buttons from the Standard toolbar.

75 SOLIDWORKS ~ File View Tools\ * N - - .
™ - Iaxs . §0p - Search Commands ~ Q ~
®@ @ - [ =

The following default tools are available:

e  Welcome to SOLIDWORKS o - Open the Welcome dialog box; New 0. Create a
new document; Open arg Open an existing document; Save & - Save an active

document; Print =1 Print an active document; Undo 2 - Reverse the last action;

Redo & Redoes the last action that you reverse; Select %

PAGE 1-7
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Overview of SOLIDWORKS® and the User Interface SOLIDWORKS® 2023 Quick Start

components and more; Rebuild ' - Rebuild the active part, assembly or drawing;
File Properties == - Summary information on the active document;

Options . Change system options and Add-Ins for SOLIDWORKS; Login ®.

Login to SOLIDWORKS. You will need to create an account with a password; Help @
- access to help, tutorials, updates and more.

Menu Bar menu (No model open) S
. - 2S SOLIDWORKS File View Tools
SOLIDWORKS provides a context-sensitive menu

structure. The menu titles remain the same for all
three types of documents

(Pal’ts, Assemblies and D5 SOLIDWORKS ~ File View Tools # ﬁ D - @ -

: [
Drawings), but the menu
items change depending on which type of document is active.

Menu Bar menu (Model open)

The Pin * option displays the Menu bar toolbar and the Menu bar menu as illustrated.
Throughout the book, the Menu bar menu and the Menu bar toolbar are referred to as the
Menu bar.

P N m N I = =
S SOLIDWORKS File Edit View Insert Tools Window ’k @ % By = = lg - . T [& N {é\}
o > "

File Edit View Insert Tools Window ﬁ

Drop-down menu (Open part document)
New... Ctrl+N

SOLIDWORKS takes advantage of the familiar Microsoft” > g::;ecem =
Windows user interface. Communicate with SOLIDWORKS & open prawing
through drop-down menus, Context sensitive toolbars, [ Close Curl+w

Consolidated toolbars or the CommandManager tabs.
To close a SOLIDWORKS drop-down menu, press the Esc

Make Drawing from Part

& %2

Make Assembly from Part

. & s Ctrl+S
key. You can also click any other part of the SOLIDWORKS S::Z e "
Graphics window or click another drop-down menu. Save All

Page Setup...
@ Print Preview...
Print... Ctrl+P
& Print3D...
4@ Publish to eDrawings
@ Pack and Go...

Send To...

Find References...
Properties...

Exit

Customize Menu
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Create a New Part Document

Activity: Create a new Part Document.

A part is a 3D model, which consists of features. What are features? Features are geometry
building blocks. Most features either add or remove material. Some features do not affect
material (Cosmetic Thread).

Features are created either from 2D or 3D sketched profiles or from edges and faces of
existing geometry.

Features are individual shapes that combined with other features make up a part or assembly.
Some features, such as bosses and cuts, originate as sketches. Other features, such as shells
and fillets, modify a feature's geometry.

Features are displayed in the FeatureManager.
w s

A The first sketch of a part is called the Base Sketch. The Base sketch is the foundation for
the 3D model. The book focuses on 2D sketches and 3D features.

w1

A FeatureManager tabs, CommandManager tabs, Task Pane tabs and tree folders will vary
depending on system setup, version, and Add-ins.

D7SSOIJDWORK5 File Edit View Insert Tools Window > ﬁ D N @ - T @ ® — D X
ﬂ g fSwept Boss/Base Dé @ ﬁ Swept Cut @ EE @ Rib Wrap

Extruded Revolved i Extruded Hole Revolved @ Fillet Linear i é @
Lofted B B Lofted Cut Draft Int: ct
Boss/Base Boss/Base ot Bose/Basd Cut  Wizard Cut ofted =y Pattern e neerse

: @ Shell Hc{] Mirror A

@ Boundary Boss/Base

? BR¢@ - AP0 » @R T

@ Bracket (Default) < <Default>_ ™
History
Sensors
Annotations
Solid Bodies(1)
§5 Material <not specified>
(1l Front Plane

(Y Top Plane

(il Right Plane

I_. Origin

@ Extrude-Thin1 l
7 X

? Fillet1 v

& > *Isometric
_ Model | Motion Study 1 |
ISOLIDWORKS Premium 2023 SP0.1 Editing Part MMGS -

Part FeatureManager
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Overview of SOLIDWORKS® and the User Interface

There are two modes in the New
SOLIDWORKS Document dialog
box: Novice and Advanced. The
Novice option is the default option
with three templates. The
Advanced mode contains access to
additional templates and tabs that
you create in system options. Use
the Advanced mode in this book.

Create a new part.

5) Click New from the Menu
bar. The New SOLIDWORKS
Document dialog box is
displayed.

Select the Advanced mode.

6) If needed, click the Advanced
tab. The below New
SOLIDWORKS Document box
is displayed.

7) Click the Templates tab.

8) Click Part. Part is the default
template from the New

SOLIDWORKS Document
dialog box.

9) Click OK from the New
SOLIDWORKS Document
dialog box.

The Advanced mode remains

SOLIDWORKS® 2023 Quick Start

New SOLIDWORKS Document

Part Assembly

3D representation of a single design

component assemblies

Novice mode

Advancet

23D arrangement of parts and/or other

OK

[
£h5

Drawing

3 2D engineering drawing, typically of a
part or assembly

Cancel Help.

New SOLIDWORKS Document

Templates MBD  Tutorial

B
Assembly
Eﬂ Drawing

Advanced mode

Novice

OK

SIS

Preview

Cancel Help

selected for all new documents in the current SOLIDWORKS session. When you exit
SOLIDWORKS, the Advanced mode setting is saved.

The default SOLIDWORKS installation contains three tabs in the New SOLIDWORKS
Document dialog box: Templates, MBD, and Tutorial. The Templates tab corresponds to the
default SOLIDWORKS templates. The MBD tab corresponds to the templates utilized in the
SOLIDWORKS (Model Based Definition). The Tutorial tab corresponds to the templates
utilized in the SOLIDWORKS Tutorials.
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Partl is displayed in the FeatureManager and is the name of the document. Part] is the default
part window name.

The Part Origin ’L is displayed in blue in the center of the Graphics window. The Origin
represents the intersection of the three default reference planes: Front Plane, Top Plane and
Right Plane. The positive X-axis is horizontal and points to the right of the Origin in the Front
view. The positive Y-axis is vertical and points upward in the Front view. The

FeatureManager contains a list of features, reference geometry, and settings utilized in the
part.

[

~ hd T . . MKS (meter, kilagram, second
" Edit the document units directly from the Graphics window A
. CGS (centimeter, gram, second)
as illustrated.

.
-

MMGS (millimeter, gram, second)
Wl D IPS (inch, pound, second)
“¥" FeatureManager tabs, CommandManager tabs, Task Pane Edit Document Units...

tabs will vary depending on system setup, version, and Add-ins.

/ Main menu toolbar

> =
DS SOLIDWORKS File Edit View Insert Tools Window » @ D o @ L ¥ @ ® - D X

Extruded Revolved
Boss/Base Boss/Base

~

Features | Sketch! Markup  Evaluate = MBD Dimensions =~ SOLIDWORKS Add-Ins ‘ ﬂ 1 _ 3 X
5 4 \
i ‘Cor"‘nmandManager Heads-up View Toolbar
& Part1 (Default) < <Default: T
[@ History Part FeatureManager Task Pane

[@ sensors \
» [A Annotations
‘,‘5 Material <not specifiec \ V\

AeETee

[J Front Plane N
[l Top Plane Hide/Show Origin
(1) Right Plane FeatureManager tab
1., Origin

J Triad

zA X
< > | *Isometric

| Model | Motion Study 1
SOLIDWCIRKS Premium 223 SP0.1 Editing Part ,IPS ’

Model Mode  Motion Mode Activity Units Tag

@
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View the Default Sketch Planes.

10) Click the Front Plane from the FeatureManager.
11) Click the Top Plane from the FeatureManager.
12) Click the Right Plane from the FeatureManager.

13) Click the Origin from the FeatureManager. The Origin is the intersection of the Front, Top, and
Right Planes. The Origin point is displayed.

14) Click inside the Graphics window.

75 soLpworks File Edit View Insert Teols Window * ﬁ D % B} = 5 @ ® - O X
Extruded Revolved
Boss/Base Boss/Base
3 h 0 ~
Features  Sketch \ Markup Evaluate| MBD Dimensions = SOLIDWORKS Add-Ins ‘ E E _ 5 X
. PLEPEH O o S/ T
% $ ‘1 - e
= ) . Right Plane L
@ Part1 (Default) < <Default -@
@l History =1
%] sensars @
+ [& Annotations = |
55 Material <not specifiec * E
() Front P
1] Top Plal Cepd
LI Right Pk e
1., Origin e
y
zle
< 2 | *Isometric
Model | Motion Study 1 |
Part1 Editing Part s - &

Download the SOLIDWORKS-MODELS 2023 folder from the SDC Publication website
(www.SDCpublications.com/downloads/978-1-63057-560-1). Open the Bracket part.
Review the features and sketches in the Bracket FeatureManager.

Work directly from a local hard drive.

Activity: Download the SOLIDWORKS folder. Open the Bracket Part.

Download the SOLIDWORKS folder. Open an existing SOLIDWORKS part.
15) Download the SOLIDWORKS-MODELS 2023 folder.

LA - [E] - . -
16) Unzip the folder. Work from the unzip folder. EK . g *)
—

17) Click Open B;/ from the Menu bar menu. Open (Ctrl+0)
18) Browse to the SOLIDWORKS-MODELS-2023\Bracket Opens an existing document.
folder.

19) Double-click the Bracket part. The Bracket part is displayed
in the Graphics window.
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D7S SOLIDWORKS

ROFE @ ® - O x
B W B B EE Are Egwer

Extruded Hole Revolved m Fillet Linear
Cut  Wizard Cut Lofted Cut S % Draft [@ Intersect
@ Boundary Cut

File Edit View Insert Tools Window

@ 3 f Swept Boss/Base

Extruded Revolved i
Boss/Base Boss/Base Lidp e

Boundary Boss/Base

] . (Wshen BfIMiror A
Features Sketch Markup‘ Evaluate‘ MBD Dimensions ‘ SOLIDWORKS Add-Ins

S EBee reves
T

& Bracket (Default) <<Default>_ *

History

[El sensors

[&] Annotations

[@]Solid Bodies(1) e

§5Material <not specified> —
[J Front Plane

[J Top Plane
[ Right Plane
k. Origin
@ Extrude-Thin1
B Fillet1
» [@@50 (5) Diameter Holel

*Isometric

< >
Model | Motion Study 1 |

SOLIDWORKS Premium 2023 SP0.1

The FeatureManager design tree is located on the left side of the SOLIDWORKS Graphics
window. The FeatureManager provides a summarized view of the active part, assembly, or
drawing document. The tree displays the details on how the part, assembly or drawing
document was created.

M ®5ETSE @

Editina Part MMGS - %

Use the FeatureManager rollback bar to temporarily roll back to an earlier state, to absorbed
features, roll forward, roll to previous, or roll to the end of the FeatureManager design tree.
You can add new features or edit existing features while the model is in the rolled-back state.
You can save models with the rollback bar placed anywhere.

In the next section, review the features in the Bracket FeatureManager using the Rollback bar.

Activity: Use the FeatureManager Rollback Bar option.

Apply the FeatureManager Rollback Bar. Revert to an earlier state in the model.

20) Place the mouse pointer over the rollback bar in the FeatureManager design tree as illustrated.

The pointer changes to a hand T, Note the provided information on the feature. This is called
Dynamic Reference Visualization.

> @ Extrude-Thin1 ' @ Btrude-Thint
21) Drag the rollback bar up the FeatureManager B Filer ® Fillet1
. g ng s ile
design tree until it is above the features you . _ » (@250 (5) Diameter Hole1
. . 4 @QS.O (5) Diameter Hole1 s
want rolled back, in this case 10.0 (10) B | patternt P Lpatternt
i » [P @100 (10) D Hole1
Diameter Hole1. > 127 2100 (10) DiameteRdole T E:%LP . (2) fameter Hole
e LPattern2 atern
22) Release the mouse button. L » [@ cut-Extrudet
» &) Cut-Extrude1 BD | pottorn3
E[ LPattern3 b
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Overview of SOLIDWORKS® and the User Interface

View the first feature in the Bracket Part.

23)
window. This is a great feature to re-engineer a pa

SOLIDWORKS® 2023 Quick Start

Drag the rollback bar up the FeatureManager above Fillet1. View the results in the Graphics

rt.

2
PS5 SOLIDWORKS File Edit View Insert Tools Window

@ 9 f Swept Boss/Base @

Extruded Revolved i Lofted Boss/Base

Boss/Base Boss/Base Cut  Wizard

Boundary Boss/Base

Extruded Hole Revolved

= PE®e® - 0O x
Swept Cut Bk Rib ﬂ Wrap

o ﬁ B d

N " - Draft Intersect

m fted Cut illet Linear B [@

Pattern
@ Boundary Cut

. @snell B viror

Cut
A

Features Sketch ‘ Markup‘ Evaluate | MBD Dimensions ‘ SOLIDWORKS Add-Ins ‘

OO _&x

SBER S @
N
@3 Bracket (Default) < <Default>_ ~
> History
[ Sensors

» [&] Annotations

» [@Solid Bodies(1)
3 Material <not specified>

[ Front Plane

[ Top Plane

[ Right Plane

s Origin

&) Extrude-Thin1
(= Fillet1

@ @50 (5) Diamet:s

er Hole1 >
ft LPattern1i

[#310.0 (10) Diameter Hole1

-

-

Y

A

PLEH

XY 1=

MO TSE @

t:L‘t LPattern2 v
< > “*Isometric
P Model | Motion Study 1
SOLIDWORKS Premium 2023 SP0.1 MMGS -
Return to the original Bracket Part
FeatureManager. R
24) Right-click Extrude-Thin1 in the » SE "
FeatureManager. The Pop-up » B Marku
Context toolbar is displayed. I Solid Besy '@ ,‘L @ ‘
25) Click Roll to End. View the [ Equati{Feature (Extrude-Thin1)
results in the Graphics window. s Materi Roll to Previous
[J Front Fl Rell to End
[J Top PI Comment :
[J Right F Parent/Child...
rigin % Configure Feature
» @] Extrud( X Delete...
W Fillet1 Add to Favorites
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Heads-up View toolbar p @ @ B @ B @ B % ﬁ B |:|
SOLIDWORKS provides the user with
numerous view options. One of the most useful tools is the Heads-up View toolbar displayed

in the Graphics window when a document is active.

N5 Dynamic Annotation Views 2 : Only available with SOLIDWORKS MBD (Model

Based Definition). Provides the ability to control how annotations are displayed when you
rotate models.

In the next section, apply the following tools: Zoom to Fit, Zoom to Area, Zoom out, Rotate
and select various view orientations from the Heads-up View toolbar.

Activity: Utilize the Heads-up View toolbar.

Zoom to Fit the model in the Graphics window.

&
26) Click the Zoom to Fit icon. The tool fits the model to the
Graphics window.

Zoom to Area on the model in the Graphics window.

27) Click the Zoom to Area ol icon. The Zoom to Area e
icon is displayed.

Zoom in on the top left hole.

28) Window-select the top left corner as illustrated. View the
results.

De-select the Zoom to Area tool.

29) Click the Zoom to Area e icon.

Fit the model to the Graphics window.

30) Press the f key. Fsouwoms  rie tai view vn s wnios » (3 [P @@ @ _ O x
D Fowemexe @ B W niiwem (B B Alne g .

Rotate the model. e foine & totettorstane T o8 P (a1 e Bt A e
& Boundary Boss/Buse . ety | (WMsvel BflMiror A
31) Hold the middle mouse button down. Features | Sketch Markup _ Evaluate | MBD Dimensions  SOLDWORKS Add-Ins OO x

PLRAPNE § o@D

Drag upward b, downward b, to the @
. 2
left © and to the right U to rotate the o
model in the Graphics window. =
ﬁ zi:;::lane —‘
e e
3 E\msms] Diameter Halel E
B E;mau ur(nm) Diameter Hale1 S
» [enzars
FE LPatterna = "’fg“«z

< >
T Model Motion Study 1
OLIDWORKS Premium 2023 SP0.] Ediiting Part MMGS

&
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Overview of SOLIDWORKS® and the User Interface

Display a few Standard Views.

32) Click inside the Graphics window.

33) Click Front -1 from the drop-down Heads-up
view toolbar. The model is displayed in the Front

SOLIDWORKS® 2023 Quick Start

PIEPEENV - @£ -0
e’

ﬁv

view.

34) Click Right ™ from the drop-down Heads-up
view toolbar. The model is displayed in the Right
view.

35) Click Top L= from the drop-down Heads-up

view toolbar. The model is displayed in the Top
view.

Display a Trimetric view of the Bracket model.

PREPA

ﬁ Dimetric
—y

Trimetric

36) Click Trimetric @ from the drop-down Heads-
up view toolbar as illustrated. Note your options.
View the results in the Graphics window.

SOLIDWORKS Help

2
DS SOLIDWORKS

Help in SOLIDWORKS is
context-sensitive and in HTML
format. Help is accessed in many

ﬁ 3 f Swept Boss/Base

Extruded Revolved
Boss/Base Boss/Base & roredosose

File Edit View Insert Tools Window *

@ Boundary Boss/Ba

e

A0 E-®Q - O x
B W Bowercr B IE J ggwe
Extéuded Hole Revolved mume dcu | Fillet pL:;;z::‘ iﬁ%h @Imﬁm

ut  Wizard  Cut
@Bmmdarycm s v @Shell 'l\ﬂMwmr

~

Features | Sketch Markup | Evaluate | MBD Dimensions | SOLIDWORKS Add-Ins |

ways, including Help buttons in
all dialog boxes and

SERo@ -
7
% Bracket (Default) <<Default>_~
» [ History

[ Sensors
» [& Annotations
» [i@ Solid Bodies(1)

3 Material <not specified>

PropertyManager and Help ©)
on the Standard toolbar for
SOLIDWORKS Help.

[{] Front Plane
[ Top Plane
({1 Right Plane
1, origin
+ @]l Extrude-Thin1
B Fillet!
» [@25.0 (5) Diameter Holel
b5 Lpatternt
» [3210.0 (10) Diameter Hole1
% Lpattern2 ~

< >

r Medel Motion Study 1 ‘
Displays help topics for SOLIDWORKS.

s

*Trimetric

OO _x
X TR

o@pégﬁj?@

gep e

M ® &

¥

MMGS - %
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SOLIDWORKS® 2023 Quick Start Overview of SOLIDWORKS® and the User Interface

37) Click @ from the Standard toolbar. s o @ @ 5 X
38) Click ® Help from the drop-down menu. The {2 Welcome to SOLIDWORKS Ctrl+F2
SOLIDWORKS Home Page is displayed by T Help
default. View your options. T Tutorials
API Help
_\,;I}/_ Use Web Help
“¥" SOLIDWORKS Web Help is active by default ¥® User Forum
under Help in the Main menu. Search
Release Notes
What's New
Close Help. Return to the SOLIDWORKS Graphics @ Introducing SOLIDWORKS (pdf)
window. Moving from 2D to 3D
SOLIDWORKS Rx
39) Close E SOLIDWORKS Home. Check for Updates.,
@ Get Support
SOLIDWORKS Tutorials Licenses
My Products...
Display and explore the SOLIDWORKS tutorials. About SOLIDWORKS...

40) Click @ from the Standard toolbar.

41) Click Tutorials. The SOLIDWORKS Tutorials are =7 SOLIDWORKS Tutorials — o 4
displayed. The SOLIDWORKS Tutorials are
presented by category.

42) Click the Getting Started category. The Getting J— e —
Started category provides lessons on parts, — “kh ) —
assemblies, and drawings. vnees e rouctviyTest

L =
Show Back Print

SOLIDWORKS Tutorials: Getting Started

Design Evaluation CSWP/CSWA Preparation

In the next section, close all models, tutorials and
view the additional User Interface tools.

Activity: Close all Tutorials and Models.

Close SOLIDWORKS Tutorials and models.
43) Close E3 soLIDWORKS Tutorials.

44) Click Window, Close All from the Menu bar menu. W"]dxow * ﬁ D T D

Viewport

User Interface Tools _
= New Window

The book utilizes additional areas of the
SOLIDWORKS User Interface. Explore an overview
of these tools in the next section.

Cascade
= Tile Horizontally
1] Tile Vertically
S Arrange Icons
Close All

1 Part1 *

2 Bracket *

Browse Open Documents...

Customize Menu
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SOLIDWORKS® 2023 Quick Start

Right-click

< - ®5

Right-click in the Graphics
window on a model, or in the
FeatureManager on a feature or
sketch to display the Context-
sensitive toolbar. If you are in the
middle of a command, this toolbar
displays a list of options
specifically related to that
command.

Right-click an empty space in the
Graphics window of a part or
assembly, and a selection context
toolbar above the shortcut menu is
displayed. This provides easy
access to the most commonly used

Zoom to Fit

Zoom to Area

Zoom In/Out

Rotate View

Pan

Roll View

Rotate About Scene Floc
Set Current View As...
View Orientation...
Edit Scene

Open Drawing
Recent Commands
Contour Select Tool

Customize Menu

SZREaqaS-@
FERPLBO

selection tools.

Consolidated toolbar

Similar commands are grouped together in the
CommandManager. For example, variations of the Rectangle
sketch tool are grouped in a single fly-out button as illustrated.

If you select the Consolidated toolbar button without expanding:

For some commands such as Sketch, the most commonly used

command is performed. This command is the first listed and the

command shown on the button.

For commands such as rectangle, where you may want to
repeatedly create the same variant of the rectangle, the last used
command is performed. This is the highlighted command when

the Consolidated toolbar is expanded.

System feedback icon

SOLIDWORKS provides system feedback by attaching a

symbol to the mouse pointer cursor.

The system feedback symbol indicates
what you are selecting or what the
system is expecting you to select.

As you move the mouse pointer across
your model, system feedback is
displayed in the form of a symbol,
riding next to the cursor as illustrated.

Select Tangency
Selection Tools
Zoom/Pan/Rotate
Recent Commands
Face
©) Change Transparency
@ Create Plane Parallel to Scree
Feature (Extrude-Thin1)
Comment
Parent/Child...
[ﬁ? Configure Feature
K Delete...
Add to Favorites
Save Selection
Body
Isolate
Export to DXF / DWG
FeatureWorks...

Find Similar in PartSupply

/O V- &

OIS0 A

I Corner Rectangle
=T Center Rectangle

h
H Q 3 Point Corner Rectangle
1< 3 Point Center Rectangle

[7 Parallelogram

Face - Edge-Dimension- Vertexq

by | [Re

5. ]

This is a valuable feature in SOLIDWORKS.
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SOLIDWORKS® 2023 Quick Start

Confirmation Corner

When numerous SOLIDWORKS commands are active, a symbol
or a set of symbols is displayed in the upper right hand corner of the
Graphics window. This area is called the Confirmation Corner.

When a sketch is active, the confirmation corner box displays two
symbols. The first symbol is the sketch tool icon. The second
symbol is a large red X. These two symbols supply a visual
reminder that you are in an active sketch. Click the sketch symbol
icon to exit the sketch and to save any changes that you made.

When other commands are active, the confirmation corner box
provides a green check mark and a large red X. Use the green check
mark to execute the current command. Use the large red X to cancel
the command.

w1

Overview of SOLIDWORKS® and the User Interface

[£]

th
X

|

(<]

th
X

shortcut to move the OK and Cancel buttons to the pointer location in the

Graphics window.

Heads-up View toolbar
SOLIDWORKS provides the user

AR Confirm changes you make in sketches and tools by using the D keyboard

with numerous view options from
the Standard Views, View and
Heads-up View toolbar.

Standard Views

N T e D=0 - [ I

x

The Heads-up View toolbar is a View

transparent toolbar that is displayed @‘ BE-§-o-¢20 -

in the Graphics window when a

document is active. J& é{, s @ @ @ -§-® .@& - -

You can hide, move or modify the
Heads-up View toolbar. To modify

PRPACHRI @ 2

the Heads-up View toolbar, right-
click on a tool and select or deselect
the tools that you want to display.

~

The following views are available.
Note: available views are document dependent.

e Zoom to Fit ¢ : Fit the model to the Graphics window.

e Zoom to Area <7O ' Zoom to the areas you select with a bounding box.

”
e Previous View 9 : Display the previous view.

PAGE 1-19
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SOLIDWORKS® 2023 Quick Start

o Section View @:Displayacutawayofa PORPEB o @ &

part or assembly, using one or more

<4
Cross section planes. — %
View Selector (Ctrl+SpaceBar)

° Dynamic Annotation Views @ : Only Show or hide the in-context View Selector to choose

from a variety of standard and non-standard view

available with SOLIDWORKS MBD. orientations. Press Alt to expose only the back faces of g
Control how annotations are displayed the View Selector.

when you rotate a model.

—— e e

The Orientation dialog has an option to

display a view cube (in-context View

Selector) with a live model preview. This

helps the user to understand how each

standard view orientates the model. With the

view cube, you can access additional standard views. The
views are easy to understand and they can be accessed
simply by selecting a face on the cube.

To activate the Orientation dialog box, press (Ctrl +

spacebar) or click the View Orientation @ icon from
the Heads-up View toolbar. The active model is displayed
in the View Selector in an [sometric orientation (default
view).

Click the View Selector icon in the Orientation dialog
box to show or hide the in-context View Selector.
ol

A Press Ctrl + spacebar to activate the View

Selector.

R

“¥" Press the spacebar to activate the Orientation
dialog box.

e View Orientation box % " Select a view
orientation or the number of viewports. The

m[=]unl==

options are: Top, Left, Front, Right, Back,
Bottom, Single view, Two view - Horizontal,
Two view - Vertical, Four view. Click the drop-
down arrow to access Axonometric views:
Isometric, Dimetric and Trimetric.

e Display Style @ “: Display the style for the
active view. The options are: Wireframe,
Hidden Lines Visible, Hidden Lines Removed,
Shaded, Shaded With Edges.
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SOLIDWORKS® 2023 Quick Start Overview of SOLIDWORKS® and the User Interface

o Hide/Show Items ® “: Select items to hide or show in the Graphics
window. The available items are document dependent. Note the View
Center of Mass # icon.

e Edit Appearance’ @ : Edit the appearance of entities of the model.

o Apply Scene ﬁ “: Apply a scene to an active part or assembly
document. View the available options.

o View Setting E3 - Select the following settings: RealView Graphics,
Shadows In Shaded Mode, Ambient Occlusion, Perspective and
Cartoon.

e Rotate view C : Rotate a drawing view. Input Drawing view angle
and select the ability to update and rotate center marks with view.

e 3D Drawing View & Dynamically manipulate the drawing view in
3D to make a selection.

To display a grid for a part, click Options il , Document Properties tab.
Click Grid/Snaps, check the Display grid box.

¥ Add a custom view to the Heads-up View =
toolbar. Press the space key. The Orientation dialog @ Faviow raphic
-]
box is displayed. Click the New View @ tool. The D st n st e
Name View dialog box is displayed. Enter a new @ smbient Occlusion
. . % Perspective
named view. Click OK. © coroon

Use commands to display information about the triad

or to change the position and orientation of the triad. |~ I ] E‘S\EH
Available commands depend on the triad's context. Aépt-.ons
\ Changes options settings for
- SOLIDWORKS.

‘¥ Save space in the CommandManager, limit

Enable CommandManager

<Jl<]

your CommandManager tabs. Right-click on a !
| ¥ | Use Large Buttons with Text

CommandManager tab. Click Tabs. View your abs [ Features
options to display CommandManager tabs. foolbars [l sketch

Customize... Sketch Ink

Surfaces
Sheet Metal
Structure System
Weldments
Mold Tools
Mesh Modeling
Data Migration
Direct Editing
Markup

Evaluate

MBD Dimensions

Render Tools
SOLIDWORKS Add-Ins
Analysis Preparation
SOLIDWORKS CAM
SOLIDWORKS CAM TBM
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SOLIDWORKS CommandManager

The SOLIDWORKS CommandManager is a Context-sensitive toolbar. By default, it has
toolbars embedded in it based on your active document type. When you click a tab below the
CommandManager, it updates to display that toolbar. For example, if you click the Sketch tab,
the Sketch toolbar is displayed.

w1

“¥* For commercial users, SOLIDWORKS Model Based Definition (MBD) and
SOLIDWORKS CAM is a separate application. For education users, SOLIDWORKS MBD
and SOLIDWORKS CAM is included in the SOLIDWORKS Education Edition.

Below is an illustrated CommandManager for a Part document. Tabs will vary depending on
system setup and Add-ins.

8 S0UDWORKS File Edit View Insert Tools Window % @ D = @' M = - ‘ % " ‘ {l‘é} "
@ 3 fs-uept Boss/Base ﬂjé;t @ ﬁSWEpt Cut @ EE @ Rib W’EF’ .ii-" U n\:‘

i i Instant3D)|
Extruded Revolved iLD"Ed Ber/En Extruded Hole Revolved @ Lofted Cut Fillet Linear eDra& [@ D Reference Curves

Boss/Base Boss/Base Cut  Wizard Cut Pattern Geomeatry
@) Boundary Boss/Base : Browndarycue ([ snen B Miror i
Features | Sketch Markup | Evaluate MBD Dimensions SOLIDWORKS Add-Ins DD Sgndy
=20 ]
% & LSON-EH T e winor tiies s @ Z &
Exit | Smart LY @ Irim Convert Offset Offset [k Display/Delete Repair Rapid Instant2D
| fat ENOE Linear Sketch Pattern -
Sketch| Dimension A Entities Entities Entities [ [ Hnear Skeieh Fatiem Relations  Sketch 5ap- Sketch
A e a0 oy
. Y- & 5 '
o ; @ ; . Move Entities ; .
Features ‘ Sketch Markup| Evaluate | MBD Dimensions. | SOLIDWORKS Add-Ins 0 Ol agac- @

Color W Erase Select Note

Features ‘ Sketch Markup = Evaluate ‘ MBD Dimensions

T Om ﬁ @ P ZE G B fp:nm 3R Devistion Analysis @namxmryg; St symmetry cnece @; pi 7 @ &
Oein ernce s Nar s Sator sansn arer <1 (37 eamety ansc Nzsraswives  Fundsranansyss S hckness ot e e e e
Wsre 5 puri e vy L1 Compore Do Dosment iz Wi
Feaures Skeich Markup | Evaluate  MBD Dimensions _ SOLIDWORKS Add Ins & 00 _ 4
$ @ & A = & 8 0 o=
Auto Location Size Angle Basic  Pattem Datum Geometric
Dimension Dimension Dimension Dimension Location  Feature Toletance
Faatures‘sketth Markup Evalualel MBD Di‘m!nsinns ‘ SOLIDWORKS Add-Ins
@ @ % & E % ¥ K
CircuitWorks PhotoView ScanTo3D SOLIDWORKS SOLIDWORKS SOLIDWORKS SOLIDWORKS TolAnalyst
360 Mation Routing Simulation Toolbox
Features 7Sketch { Markup Evaluater‘ MBD Dimensions SOLIDWORKS Add-Ins XQ p @ @@
ol
A Set button size from the Toolbars tab of the Customize {(C)}
dialog box. To facilitate element selection on touch interfaces
such as tablets, you can set up the larger Size buttons and text 5 o&\}ons
from the Options menu (Standard toolbar). Qe
Add-Ins...
Save/Restore Settings...
B Button Size
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The SOLIDWORKS CommandManager is a Context-sensitive toolbar that automatically
updates based on the toolbar you want to access. By default, it has toolbars embedded in it

based on your active document type. The available tools are feature and document dependent.

Below is an illustrated CommandManager for a Drawing document. Tabs will vary
depending on system setup and Add-ins.

View

o > P m ==y

i K\ ni_ n7) Sﬁ - U:D -
O o* “ ,.:0 @\ 0O=A B =i ﬁ
Model Projected Auxiliary Section Removed Detail Relative Standard Broken-out Break Crop Alternate Empty Predefined g Replace
View  View View  View Section View View 3View Section View View Position View View : Model

Drawing ‘ Annotation ‘ Sketch ‘ Markup ‘ Evaluate ‘ SOLIDWORKS Add-Ins ‘ Sheet Format ‘

=

‘K Abt AAA . . o
<\ & P 4 i A AAA /®Ealloan {Surface Finish [E[03Geometric Tolerance {:‘}Cenler Mark @
Smart Model Spell Format Note Linear p Blocks [ i Tables|
Biiaciion, fhere | Bt ier Py er Note %Au(o Balloon /7<We[d Symbol Datum Feature L= Centerline m Revision Cloud
7
Pattern n Magnetic Line LI@ Hole Callout Datum Target % Area Hatch/Fill
- o = =
Drawing ‘ Annotation ‘Skel(h Markup‘ Evaluate ‘ SOLIDWORKS Add-Ins ‘ Sheet Format @ E D: /éz @
|
<\ / x @ i [U - | K IC [‘F‘i':ﬂ Mirror Entities J-o
Smart . Y = Trim ert Offset [ . . Display/Delete
Dimension 1~ e © Entities Entities [l HNe2r Sketch Pattern e ions

Drawing Annotation ‘Sket:h Markup‘ Eva{uate‘ SOLIDWORKS Add-Ins ‘ Sheet Format

Drawing ‘ Annotation | Sketch | Markup

v 8 d b b o« &

Checker Properties Evaluation Documents  Active ‘Wizard
Document

Spell Measure Markup Section Performance  Compare  Check  DriveWorksXpress

Drawing ‘ Annetation ‘ Sketch ‘ Markup ‘ Evaluate | SOLIDWORKS Add-Ins ~ Sheet Format

* @ % & E B F K

GircuitWorks PhotoView ScanTo3D SOLIDWORKS SOLIDWORKS SOLIDWORKS SOLIDWORKS TolAnalyst
360 Motion Routing  Simulation  Toolbox

Drawing Annotation = Sketch Markup‘ Evalua(e‘ SOLIDWORKS Add-Ins = Sheet Format p gj

i G2

Title Automatic
Block  Border

rawing | Annotation | Sketch Markup | Evaluate ‘ SOLIDWORKS Add-Ins | Sheet Format

w1
“¥" To add a custom tab, right-click on a tab and ‘ S e e
click Customize. You can also select to add a Enable CommandManager
blank tab and populate it with custom tools from Use Large Buttons with Text
the Customize dialog box. Ta
To%ars
Customize...
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SOLIDWORKS® 2023 Quick Start

The SOLIDWORKS CommandManager is a Context-sensitive toolbar that automatically

updates based on the toolbar you want to access. By default,

it has toolbars embedded in it

based on your active document type. The available tools are feature and document dependent.

Below is an illustrated CommandManager for an Assembly document. Tabs will vary

depending on system setup and Add-ins.

A B E P & @ e

Assembly Layout| Skelch| Markup ‘ Evaluate SOLIDWORKS Add-Ins

Insert  Mate Compone Linear Smart Move Show Assembly Reference New  Bill of Exploded (Inst: Update Take Large
Components P Component Fasteners Component  Hidden Features Geometry Motion Materials ~ View SpeedPak  Snapshot Assembly
Pattern Components Study | Subassemblies Settings

H o 8 @ %

g & ON#EE Bl e
Create  Smart D_{\_O_A : Convert Offset

Hargl Al Q " Insert  Mate  Move Show
layout Dimension e Entltles Friities  On ) : Relat Components Component  Hidtden

T e Surece g e ¢ camporens
Assembly Layout Sketch Ma.kup\mium SOLIDWORKS Add-Ins 2 L6 B % -

2 ® &

E O /SO g @
Sketch  Smart D‘O'@'A T . Convert Of Offset

Dimension ies Entities Entities  On

% @ -\ Surface

Z &

Rapid Instant2D
Sketch

Assembly Layout ‘ Sketch ‘ Markup ‘ Evaluate ‘ SOLIDWORKS Add-Ins

rase Select Note

Assembly  Layout ‘ Sketch ‘ Markup ‘ Evaluate ‘ SOLID|

e L B et o b BR e ho

Design Interference Clesrance  Hale  Messure Markup  Mass S mor Assembly P < Curvalure Symmetry Body  Compare  Check
Study  Detection Verfication Aligrment Properties Propertie Visualizstion Check  Compare Documents  Active

Dacument

Assembly Layout Sketch Markup Evaluate SOLIDWORKS Add-Ins SRSy 4 i1=H b

s og B B2 @ &

SimulationXpress HoXpress DriveWorksipress Costing  Sustainability  On Demand
Analysis Wizerd  Analysis  Wizard Manufacturing
wi

o @@ o 1

@,
w @ % & E &
CircuitWorks PhotoView ScanTo3D SOLIDWORKS SOLIDWORKS SOLIDWORKS SO
Motion Routing  Simulation

Assembly _Layout | Sketch | Markup | Evaluate | SOLIDWORKS Add-Ins

LIDWORKS TolAnalyst
Toolbox

w1

A The Markup tab is displayed by default in the
CommandManager on some systems. You can draw
markups with a mouse on non-touch devices, display
bounding boxes for markups, create markups in drawings,
and use the context toolbar to access markup options.

The Markup toolbar displays different options depending on
4

the device. Draw praw and Touch Tuch are not available for
non-touch devices.
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SOLIDWORKS® 2023 Quick Start

Float the CommandManager. Drag the Features, Sketch or any
CommandManager tab. Drag the CommandManager anywhere on or
outside the SOLIDWORKS window.

To dock the CommandManager, perform one of the following:

While dragging the CommandManager in the SOLIDWORKS
window, move the pointer over a docking icon -

Dock left Dock right
and click the needed

Dock above M

»

-

b b

command.

Double-click the floating CommandManager to revert the
CommandManager to the last docking position.

Collapse the CommandManager

Collapse the CommandManager to only display the available tabs.
No tools are shown.

Click the Collapsed CommandManager arrow to the right of the
active CommandManager tab as illustrated. Only the tabs are
displayed.

Overview of SOLIDWORKS® and the User Interface

mmandManager
@ CircuitWorks
Q PhotoView 360

@o ScanTo3D

@' SOLIDWORKS Motion
:E SOLIDWORKS Routing
@ SOLIDWORKS Simulati..
T soLDWORKS Toolbox
EI TolAnalyst

£S SOLIDWORKS Flow Si...

o
TP SOLIDWORKS Plastics

‘SOLIDWORKSAdd-Ins ‘MBD Dimensions ‘Evaluate ‘Markup ’Sketch ‘Features kol

To display the CommandManager tools back, click on
a CommandManager tab. Click the Pin

a @

X

@ ¥

CommandManager as illustrated.

~

‘ Collapse CommandManang

2
PS SOLIDWORKS

File Edit View Insert Tools Window »*

o D

Features ‘ Sketch ‘ Markup ‘ Evaluate ‘ MBD Dimensions ‘ SOLIDWORKS Add-Ins ‘
1

Extruded Hole Revolved Fillet Linear

Cut  Wizard Cut

Extruded Revolved
Boss/Base Boss/Base

m Lofted Cut
@ Boundary Cut

‘ Lofted Boss/Base

@ Boundary Boss/Base

e B Draft @ Intersect Ge

. @ Shell F‘Eﬂ Mirror

DZYSOLIDWORKS File Edit View Insert Tools Window @ - IE - T g - N [} M e @ -
Featpres Sketch‘ Markup‘ Evaluate ‘ MBD Dimensions ‘ SOLIDWORKS Add-Ins ‘ -
%\% 3 f Swept Boss/Base Dé @ ﬁ Swept Cut @ EE @ Rib Wrap oE%i U h\\'\j

Reference Curves Instant3D
ometry

® ®

H X

Pin CommandManager
I
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Part FeatureManager Design Tree
The Part FeatureManager consists of various tabs:
o FeatureManager design tree @ tab.

e PropertyManager tab.

o ConfigurationManager 5 tab.

o  DimXpertManager D tab.

e DisplayManager é tab.

o CAMF eatureManager tree N . " | tab.

e  CAM Operation tree I tab.

e CAM Tools tree ' tab.

Click the direction arrows to expand or
collapse the FeatureManager design tree.

CommandManager and FeatureManager tabs
and folder files will vary depending on your
SOLIDWORKS applications and Add-ins.

Select the Hide/Show FeatureManager Area tab

&E as illustrated to enlarge the Graphics window
for modeling.

SOLIDWORKS® 2023 Quick Start

% Bracket (Default<<Default>_Display State 1>)

» [@ [®©] History

Sensors

{A] Annotations

Solid Bodies(1)

55 Material <not specified>
(7 Front Plane

(! Top Plane

[J Right Plane

L Origin

&)]) Extrude-Thin1

@ Fillet1

(& @5.0 (5) Diameter Hole1
&% LPatternt

@ @10.0 (10) Diameter Hole1
&% LPattern2

Cut-Extrude1

&% LPattern3

v

v

v

v

v

-

[ Top Plane

[J Right Plane

1, Origin

@ Extrude-Thin1

B Fillet1 0

& @5.0 (5) Diameter His il

&% LPattern1 ‘Hide FeatureManager Tree Area

(& ©10.0 (10) Diameter
EE LPattern2
Cut-Extrude1

3@ LPattern3

ol

“¥* The Sensors tool = :

located in the FeatureManager % [E $ e H‘% © ‘ | 5 ‘ © ‘ @ | TWT
monitors selected properties in |V Sensor

a part or assembly and alerts G FLATBAR (Default<<Default>_D v X
you when values deviate from History Sensor Type ~
the specified limits. There are } o dd Rensor... 2 Mass Properties v
five sensor types: Simulation ':A';:: Noti,%tions_" E— ~
Dgta, Mass properties, oﬁ? Eren Rename tree item Iz ‘Mass e ‘
Dimensions, Measurement and 2 Top Hide/Show Tree Items..

Costing Data. [ Righ Collapse Items ®

1, origi Customize Menu
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SOLIDWORKS® 2023 Quick Start

Various commands provide the ability to
control what is displayed in the
FeatureManager design tree.

1. Show or Hide FeatureManager items.

AR Click Options €5 - from the Menu
bar. Click FeatureManager from the
System Options tab. Customize your
FeatureManager from the Hide/Show tree
Items dialog box.

2. Filter the FeatureManager design tree.
Enter information in the filter field. You
can filter by Type of features, Feature

Overview of SOLIDWORKS® and the User Interface

System Options

System Options

5 Document Properties

FeatureManager x
G scarch Options
s
O
O
Zoymamic ighight

import
Export

Messages/Errors/Warnings

[ Enable preview ofhidden components
A Edit name with slow double click
Clshow

fed feature names n FeatureManager tree Chinese-simplified

Hidejshow tree items

[@siocks [ equations

[0 Design Binder

3 Materil

¥ Cefault lanes
@] sofid Bodies L. origin
(@] Surface Bodies [ Mate References.

[ Tables 5k Design Table

names, Sketches, Folders, Mates, User-
defined tags and Custom properties.

w1

A Tags are keywords you can add to a SOLIDWORKS
document to make them easier to filter and to search. The
Tags & icon is located in the bottom right corner of the

. . C Sketch1
Graphics window. ~ [B@5.0 (5) Diameter Hole1
e (U Sketch3
A Collapse all items in the FeatureManager, right-click _ e
. . - @100 (10) Diameter Hole1
and select Collapse items, or press the Shift + C keys. U Sketchs
The FeatureManager design tree and the Graphics window ; gj;t:::ﬂ
are dynamically linked. Select sketches, features, drawing  sketché

views, and construction geometry in either pane.

Split the FeatureManager design tree and either display

two FeatureManager instances, or combine the

FeatureManager design tree with the
ConfigurationManager or PropertyManager.

Move between the FeatureManager design tree,

PropertyManager, ConfigurationManager,

DimXpertManager, DisplayManager and others by

selecting the tab at the top of the menu.

SLERe@>
ketch X
% Bracket (Default< <Default>_Dis

» [A] Annotations
~ @] Extrude-Thin1

/L,%% A E

@ FLATBAR (Default< <Default: A
History
@ sensors

» [&] Annotations

» [@ Solid Bodies(1)
X Equations

¥S4.2014 Alloy Y
< >
=+ o

=+
G &/@
nfigurations

~ & FLATBAR Configuration(s) (I
» [ETables
[  Default [ GIDS-SC-104

[ — 3HOLE [ GIDS-SC-100)

[ — 5HOLE [ GIDS-SC-100)

[ — 7HOLE [ GIDS-SC-100]

Split
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The ConfigurationManager 2 tab is located to the

right of the PropertyManager tab. Use the
ConfigurationManager to create, select and view
multiple configurations of parts and assemblies.

The icons in the ConfigurationManager denote
whether the configuration was created manually or
with a design table.

The DimXpertManager & tab provides the ability to
insert dimensions and tolerances manually or
automatically. The options are: Auto Dimension

& Auto Pai -
Scheme ¥, Auto Pair Tolerance ™3, Basic,
Location Dimension , Basic Size Dimension

= , General Proﬁle Tolerance % , Show
Tolerance Status %o , Copy Scheme % , Import

Scheme H}, TolAnalyst Study * Kl and Datum
Target

w1

¥ TolAnalyst is available in SOLIDWORKS
Premium.

Fly-out FeatureManager

The fly-out FeatureManager design tree provides the
ability to view and select items in the
PropertyManager and the FeatureManager design
tree at the same time.

Throughout the book, you will select commands and
command options from the drop-down menu, fly-
out FeatureManager, Context toolbar, or from a
SOLIDWORKS toolbar.
w1

" Another method for accessing a command is to
use the accelerator key. Accelerator keys are special
keystrokes, which activate the drop-down menu
options. Some commands in the menu bar and items
in the drop-down menus have an underlined
character.
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©ER® -
chonfigurationManagerL

- @ FLATBAR Configuration(s) (Default)
v [ETables
[  Default [ GIDS-SC-10009-9 ]
[ — 3HOLE [ GIDS-SC-10009-3 |
[ — SHOLE [ GIDS-SC-10009-5 |
[ — 7HOLE [ GIDS-SC-10009-7 |

SER @

@ (BN DimXpertManager[* EI

T T
: T &riameAl ,M
SER®@ -
B sensers
B LPatternt » [A Anndftations
v X > [@lsolid|Bodies(1
3 .
Direction 1 A Equa ons
2 ‘Edge<1 N ‘ S/ 6061 |Alloy
@ Frong Plane
® Spacing and instances Q Top Rlane
O Up to reference i Right| Plane
&y 0.500in ‘ =] L. origi
» &l Boss{ExtrudeT
oh 3 ‘ =] » B cyt-xtrudet
[T §
Direction 2 v ol L prn’
Features and Faces AL
@ Cut-Extrude1 ‘ j
@
[Bodies v
Instances to Skip v
Options A
Vary sketch
Geometry pattern
Propagate visual
properties
O Full preview
@ Partial preview
Y
D Instances to Vary v
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Task Pane

The Task Pane is displayed when a SOLIDWORKS session starts. You can show, hide, and
reorder tabs in the Task Pane. You can also set a tab as the default so it appears when you
open the Task Pane, pin or unpin to the default location.

The Task Pane contains the following default tabs:

e  3DEXPERIENCE Marketplace @ (Add-in).
o  SOLIDWORKS Resources @

e Design Library @ .

o File Explorer B

e View Palette . e Ckség% :? g 7

7 annotations
> =V assemblies

o Appearances, Scenes and Decals

e Custom Properties == > Dfeatures
> g forming tools
e V= motion
‘¥ Additional tabs are displayed with Add-Ins. > I s
> [=routing

7 smart components
> I SOLIDWORKS Content
%3D Components - PartSupply
> F Toolbox

Use the Back and Forward buttons in the Design
Library tab and the Appearances, Scenes, and Decals
tab of the Task Pane to navigate in folders.

M®ETee @

3DEXPERIENCE MARKETPLACE

.!

Click the 3DEXPERIENCE MARKETPLACE icon to
connect to the 3DEXPERIENCE platform and leverage its
collaboration, product data and lifecycle management, organic
shape design, simulation solutions, and more. (Subscription
required.)

Use 3DEXPERIENCE MARKETPLACE to source 3D
content and services worldwide. This is a SOLIDWORKS
Add-in.

3DEXPERIENCE

Extend
SOLIDWORKS
with the
3DEXPERIENCE
Platform

gre»e

fl®

Connect to the
3DEXPERIENCE®
platform and
leverage its
collaboration, product
data and lifecycle
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SOLIDWORKS Resources

The SOLIDWORKS Resources @ icon displays the following
default selections:

o Welcome to SOLIDWORKS.
e  SOLIDWORKS Tools.

e Online Resources.

e Subscription Services.

Other user interfaces are available during the initial software
installation selection: Machine Design, Mold Design, Consumer
Products Design, etc.

Design Library

The Design Library @ contains reusable parts, assemblies,
and other elements including library features.

The Design Library tab contains default selections. Each default
selection contains additional sub categories.

The default selections are:

SOLIDWORKS® 2023 Quick Start

& Welcome to SOLIDWORKS

SOLIDWORKS Tools

@ Property Tab Builder
@, SOLIDWORKS Rx

@ Performance Benchmark Test

Compare My Score

a Copy Settings Wizard

@ My Products

Online Resources

AeHTee

@® 3DEXPERIENCE Marketplace

= Partner Solutions

Subscription Services

HIEYINIEIEY )

| L vesignlibay &

v () Design Library

GOBES ¥

= annotations
> [=assemblies
> [ features
> a-;;: forming tools
= motion
> [=parts
> [=rrouting
= smart components
> § Toolbox
> @I SOLIDWORKS Content
# 3D Components - PartSupply

Kl

TolAnalyst SOLIDWORKS SOLIDWORKS SOLIDWORK]

o
T

~s
AL
B4

Flow
Simulation

Plastics 1spection

e Design Library.
T & 7
e  SOLIDWORKS Content ( Internet SOLIDWORKS SOLIDWORKS |SOLIDWORKS
access required). Routing Simulation Toolbox
e Toolbox. s | soLbworks Add-ins | |
e 3D Components - PartSupply.
w1

A Activate the SOLIDWORKS
Toolbox. Click Tools, Add-Ins.., from
the Main menu. Check the
SOLIDWORKS Toolbox Library and
SOLIDWORKS Toolbox Ultilities box
from the Add-ins dialog box or click
SOLIDWORKS Toolbox from the
SOLIDWORKS Add-Ins tab.

SOLIDWORKS Toolbox

Loads or unloads the SOLIDWORKS Toolbox add-in.

N
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Overview of SOLIDWORKS® and the User Interface

To access the Design Library folders in a non-network environment, click Add File Location

@ and browse to the needed path. Paths may vary depending on your SOLIDWORKS
version and window setup. In a network environment, contact your IT department for system

details.

File Explorer

File Explorer = duplicates Windows Explorer from your local
computer and displays:

e Recent Documents.

o Samples.

e Open in SOLIDWORKS
o Desktop.

View Palette

The View Palette tool located in the Task Pane provides the
ability to insert drawing views of an active document, or click the
Browse button to locate the desired document.

Click and drag the view from the View Palette into an active
drawing sheet to create a drawing view.

w1

W The selected model is Bracket.

Appearances, Scenes, and Decals

Appearances, Scenes, and Decals e provide a simplified way
to display models in a photo-realistic setting using a library of
Appearances, Scenes, and Decals.

An appearance defines the visual properties of a model, including
color and texture. Appearances do not affect physical properties,
which are defined by materials.

Scenes provide a visual backdrop behind a model. In
SOLIDWORKS they provide reflections on the model.
PhotoView 360 is an Add-in. Drag and drop a selected
appearance, scene or decal on a feature, surface, part or assembly.
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v &0 Open in SOLIDWORKS A
% Bracket
Bracket - Sheet1.slddrv
® Partl.sldprt

v Il Desktop (laptop-hncqqu67)
> o Creative Cloud Files

> @ OneDrive
> 2 Dave Planchard

> ®This PC

> '+ Libraries

> [EH Control Panel
> 3DPrintr

)BT e @

A®ETIED e

Bracket
Options

| Import Annotations
Design Annotations

DimXpert Annotations

Include items from hidden features
3D View Annotations

Auto-start projected view

Drag views onto drawing sheet.

L B .

(A) Front (A) Top

€

v O Appearances(color)

> V@ Plastic

> F@Metal
> V@ Painted
> F@Rubber
> F@Glass

V@ Solid
> F@Lights

> V@ Fabric
> @Organic

> ﬁStone
> V@ Miscellaneous

M®ETSE> @

> & Scenes
> @ Decals

Default Appearance: color

texture
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Custom Properties mwy Reset

A property page for part files was
not found. Click ‘Create now..." to
launch the Property Tab Builder.

The Custom Properties tool provides the ability to enter

custom and configuration specific properties directly into
SOLIDWORKS files.

Motion Study tab

If you already have a template,
place it in the folder specified in
Tools — Options — File Locations —
Custom Property Files.

Press F5 to refresh the page.

Motion Studies are graphical simulations of motion for an
assembly. Access the MotionManager from the Motion Study
tab. The Motion Study tab is located in the bottom left corner of
the Graphics window.

‘ Create now...

MO®HETSE@

Incorporate visual properties such as lighting and camera
perspective. Click the Motion Study tab to view the
MotionManager. Click the Model tab to return to the
FeatureManager design tree.

> > = 5 LI T

&

v L N e e e e et
A - @part2

& oriel ¢ ¢

» [ Ligh
v LS

Model | Motion Study 1 \

The MotionManager displays a timeline-based
interface and provides the following selections from the
drop-down menu as illustrated:

e Animation: Apply Animation to animate the
motion of an assembly. Add a motor and insert
positions of assembly components at various times
using set key points. Use the Animation option to
create animations for motion that do not require
accounting for mass or gravity.

e Basic Motion: Apply Basic Motion for
approximating the effects of motors, springs,
collisions and gravity on assemblies. Basic Motion
takes mass into account in calculating motion.
Basic Motion computation is relatively fast, so you
can use this for creating presentation animations
using physics-based simulations. Use the Basic
Motion option to create simulations of motion that
account for mass, collisions or gravity.

PAGE 1-32



SOLIDWORKS® 2023 Quick Start

w1

2 If the Motion Study tab is not
displayed in the Graphics window,
click View » Toolbars >

MotionManager from the Menu bar.

Overview of SOLIDWORKS® and the User Interface

View&rt Tools Window »#

£y

[ P=\ — 1 —
-

Q Red raw\
Screen Capture

Display
Modify
Lights and Cameras

Hide / Show

Toolb

rs
Work%c!\

User Interface
{5 Touch Mode
:E': Full Screen

Customize Menu

Ctrl+R

F11

E‘ Enable CommandManager

|29 2D to 3D

B 3pwox

) E Align

V'A Annotation
@ Assembly

’ Blocks
. [2 configurations

. U Curves

¢k Dimensions/Relations

# Fastening Feature

EE,! Manage Printers

Q} MBD Dimension
Display States

D«

Toolbox

Drawing

@-‘5 Explode Sketch

@ Features

87 Formatting
Layer

1 Layout Tools

== Line Format

Mold Tools
MotionManager
[® Qe Snaps

°@ Reference Geometry
@ Render Tools

==
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3D Views tab

Capture 3D View
Only available in SOLIDWORKS MBD. S
SOLIDWORKS MBD (Model Based History 5
Definition) lets you create models without the
need for drawings giving you an integrated Update Previews
manufacturing solution. MBD helps companies :_—@

srER) =\

define, organize, and publish 3D product and
manufacturing information (PMI), including
3D model data in industry standard file
formats.

Create 3D drawing views of your parts and
assemblies that contain the model settings

needed for review and manufacturing. This lets | ™55 Model 3D Views | Motion Study 1

users navigate back to those settings as they
evaluate the design.

Use the tools in the MBD Dimensions CommandManager to set up your model with selected
configurations, including explodes and abbreviated views, annotations, display states, zoom
level, view orientation and section views. Capture those settings so that you and other users
can return to them at any time using the 3D view palette.

To access the 3D View palette, click the 3D Views tab at the bottom of the SOLIDWORKS
window or the SOLIDWORKS MBD tab in the CommandManager. The Capture 3D View
button opens the Capture 3D View PropertyManager, where you specify the 3D view name,
and the configuration, display state and annotation view to capture. See help for additional
information.

Dynamic Reference Visualization @a [% .Q} e >

(Parent/Child) ’?

Dynamic Reference Visualization provides the ability T FLATBAR (Default< <Default>_Display

to view the parent/child relationships between items in | » [@] History

the FeatureManager design tree. When you hover over Sensors

a feature with references in the FeatureManager design |, £ annotations
tree, arrows display showing the relationships. If a » [i@)Solid Bodies(1)
reference cannot be shown because a feature is not Equations

expanded, the arrow points to the feature that contains
the reference and the actual reference appears in a text
box to the right of the arrow.

$2014 Alloy
[ Front Plane
(!l Top Plane

(¥ Right Plane
i, Origin

~ @) Boss-Extrude1

(&)
el
Tl
m | =~
T
A0
o | X
rD|
_\I
1
1

EE LPatternt
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Use Dynamic reference visualization for a part, g e i 7] Y B P B -
assembly and mates. r%}? » ot [Bomes @ B3 dw
To display the Dynamic Reference Visualization, . : ;"ZCW‘“ patern %;: ﬁﬂ
click View » User Interface > Dynamic R Eimess B C
Reference Visualization Parent/Child) from the Hide / Show
Main menu bar. =

User Interface’ > [¥] FeatureManager Tree Area
Mouse Movements S S St

% Tool

A mouse typically has two buttons: a primary o e
button (usually the left button) and a secondary Status Bar
button (usually the right button). Most mice also S e

include a scroll wheel between the

buttons to help you scroll through

documents and to Zoom in, Zoom out

and rotate models in SOLIDWORKS. ==

It is highly recommended that you use a K
mouse with at least a Primary, Scroll : \
; S '|
and Secondary button. ~ 4
Single-click '_I-!.'_- Primary button [ 2. Scroll wheel | 3. Secondary button

To click an item, point to the item on

the screen, and then press and release the primary button (usually the left button). Clicking is
most often used to select (mark) an item or open a menu. This is sometimes called single-
clicking or left-clicking.

Double-click

To double-click an item, point to the item on the screen, and then click twice quickly. If the
two clicks are spaced too far apart, they might be interpreted as two individual clicks rather
than one double-click. Double-clicking is most often used to open items on your desktop. For
example, you can start a program or open a folder by double-clicking its icon on the desktop.

Right-click

To right-click an item, point to the item on the screen, and then press and release the
secondary button (usually the right button). Right-clicking an item usually displays a list of
things you can do with the item. Right-click in the open Graphics window or on a command in
SOLIDWORKS, and additional pop-up context is displayed.

Scroll wheel

Use the scroll wheel to zoom-in or to zoom-out of the Graphics window in SOLIDWORKS.
To zoom-in, roll the wheel backward (toward you). To zoom-out, roll the wheel forward
(away from you).
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Summary

The SOLIDWORKS (UI) is designed to make maximum use of the Graphics window for
your model. Displayed toolbars and commands are kept to a minimum.

The SOLIDWORKS User Interface and CommandManager consist of the following main
options: Menu bar toolbar, Menu bar menu, Drop-down menus, Context toolbars,
Consolidated fly-out menus, System feedback icons, Confirmation Corner and Heads-up
View toolbar.

2 y s .
DS SOLIDWORKS File Edit View Insert Tools Window »* @ D

The Part CommandManager controls the Q) O Jswentsossase W

display of tabs: Features, Sketch, Evaluate, Bxtruded Revolved . EBtruded Hole Revolved

. . . Boss/Base Boss/Base Cut z Cut
MBD Dimensions and various o .
SOLID WORKS Add_lns' Features ‘ Sketch ‘ Evaluate = MBD Dimensions = SOLIDWORKS Add-Ins ‘

The FeatureManager consists of various tabs:

S BER SN
v

° PropertyManager tab. @) Bracket (Default< <Default>_Display State 1>)
» [@lHistory

o ConfigurationManager [ tab. Sensors

[A] Annotations

Solid Bodies(1)

o FeatureManager design tree & tab.

v

o DimXpertManager & tab.

v

55 Material <not specified>

e DisplayManager é tab. [J Front Plane

o  CAM FeatureManager tree @ tab. g :;: I:;i o

o CAM Operation tree 2 o, X %(EDXTSJZe—Thin ]
o  CAM Tools tree ﬂ tab. B Filltt

v

& @5.0 (5) Diameter Hole1
&% LPattern1

& 210.0 (10) Diameter Hole1
&% LPattern2

Cut-Extrude1
CommandManager and FeatureManager tabs and L5 LPattem3

file folders will vary depending on system set-up

and Add-ins.

You learned about creating a new SOLIDWORKS part and opening
an existing SOLIDWORKS part along with using the Rollback bar
to view the sketches and features.

v

e d
Click the direction arrows to expand or
collapse the FeatureManager design tree.

-

1 Overall drafting standard

L
EA ™ Y

If you modify a document property from an Overall drafting | ANSI-MODIHED
standard, a modify message is displayed as illustrated.

Derived from: ANSI
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w1

‘¥ Use the Search box, in the upper left corner of the Materials
dialog box, to search through the entire materials library. -
Templates are part, drawing and assembly documents which s
include user-defined parameters. Open a new part, drawing or

assembly. Select a template for the new document.

In Chapter 2, establish a SOLIDWORKS session. Learn about
2D Sketching and 3D features.

Material

v [(2] SOLIDWORKS Materials
v Steel

Create a new part. Create the Wheel for the Fly Wheel sub-
assembly.

Utilize the Fly Wheel sub-assembly in the final Stirling
Engine assembly.

Apply the following sketch and feature tools: Circle, Line
Centerline, Centerpoint Straight Slot, Mirror Entities,
Extruded Boss, Extruded Cut, Revolved Boss, Circular
Pattern, Hole Wizard and Fillet.

Incorporate design change into a part using proper design
intent, along with applying multiple geometric relations:
Coincident, Vertical, Horizontal, Tangent and Midpoint
and feature and sketch modifications.

Utilize the Material, Mass Properties, Appearance and
Measure tool on the Wheel.

PAGE 1-37



Overview of SOLIDWORKS® and the User Interface SOLIDWORKS® 2023 Quick Start

Notes:
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